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1. Introduction to ZaraStudio
ZaraStudio is an automation system for playing and managing the audio of a radio station, 
though it can also be used in any other scenario with similar requirements. 

It is designed with small and medium-sized radio stations in mind, but it can also be used in  
larger  stations without  any problems.  Broadcasting programs at  specific  times or  selecting 
random music are tasks that ZaraStudio handles easily. With it, you can automate your station 
for long periods, such as during the summer. Additionally, if your station is affiliated with a 
radio network, you can automate local disconnections for ads, provided that the 'main station'  
uses  a  telecommand  system,  either  through  contacts  on  the  computer’s  parallel  port  or 
through DTMF tones.

In contrast to other programs, ZaraStudio does not rely on a database or a server to function. It 
also  doesn’t  require  special  sound  cards,  as  it  works  with  any  Windows-compatible  card. 
However, it is recommended to use professional sound cards to achieve optimal audio quality.

Furthermore,  ZaraStudio  requires  minimal  resources  and can  run  on  basic  hardware.  It  is 
designed to be used on Windows 10 or 11.

2. The first execution
If  you plan to use the parallel port contact conslure detection feature, you will  have to run 
ZaraStudio as administrator the first time. This is due to the fact that the application needs to  
install a driver on the system that allows it to access to the parallel port pins. To do that, just  
right click on ZaraStudio icon and select Run as administrator.

Moreover, it is advisable to keep the operating system as “clean” as possible, regarding installed 
software. This way, the PC will be faster and ZaraStudio more stable. Besides, it might be a 
good practice to avoid using the computer for other purposes, such as browsing the web.

2.1. Default user
When executing the application the first time, you will see that some features are disabled. This 
is because the system opens with a limited user account by default. In order to be able to use 
all the modules, go to Tools > Change user and access with the administrator account, whose 
user name and password is “admin”.

3. The main window
ZaraStudio main window looks like this:

5



User manual ZaraStudio

All the panels of the window can be moved and anchored in the position you prefer, except the 
Events and indicators one. To do that, click with the left mouse button on the top title bar of a 
panel and, without releasing the mouse button, move it around the different window areas. 
You will see that some blue boxes will appear. If you release the mouse button, the panel will  
be anchored at the position marked by the blue box. This way, you can customize the look of 
ZaraStudio, to fit your needs and work more comfortably. You can also hide or show some 
parts of the window from the View menu, to have more space on low screen resolutions.

The main window is divided in several parts:

● Button bar

It allows you to access to several features of the program. Besides, it displays the date 
and the time and, optionally, the temperature and humidity. For more information, see 
section 4.

● Players

The players are the most important part of ZaraStudio. They are the main tool for audio 
playing, either manually or automatically.

● Audio explorer

This window enables you to manage your station audio archive, which can be stored in 
a database or, directly, in the folder structure of your hard drive.
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4. The buttons bar
The buttons bar gives you access to the following functions:

Opens the sound mixer application set in the options dialog (normally, the default 
Windows mixer).

Mutes or enables the sound card line in port specified set as 'Channel 1' in the 
options dialog. When it is pressed, it rebroadcasts the audio in the line in port.

Enables or disables voice tracking. When it is disabled, voice tracking files are not  
played.

Opens the options dialog.

Gives  access  to  the  “View”  menu,  which  allows  you  to  show  or  hide  several 
application  items,  as  the  full  file  paths  in  the  players,  the  audio  palette,  the 
weather information or the headers in the playlists. Besides, there is an option to 
display the application in full screen. You can also change the font used in the 
playlists.

Gives access to the “Tools” menu, which allows you to access to the auditor, the 
sweepers  editor,  the  schedule  editor,  the  user  management  window  or  the 
options dialog.

Allows you to open or close several playback windows: the main player, the events 
player, the auxiliary players and the audio explorer.

Opens the recording tool.

Arranges the application windows.

It displays the name of the database server to which the application is connected. 
If the connection fails, the icon will change to red. 

Name of the active user in the application. 

This icon is displayed when there is an active telecommand. Additionally,  after 
each  telecommand  is  received,  it  shows  the  time  and  type  of  the  received 
telecommand. 

5. The audio explorer
The audio explorer is the tools that enables you to manage all your audio archive and classify it  
according to the desired criteria. Besides, it allows you to load audios in the players by means 
of “drag-and-drop”.

It looks like this:
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The tool bar allows you to access to the following functions:

Enables you to create, edit and remove database audio sources, which will be explained 
later.
Enables you to create, edit and remove disk audio sources, which will be explained later.
Displays the folder structure on top of  the audio list.  This  option is  useful  with low 
resolution screens.
Displays the folder structure at the left of the audio list. This option is useful with wide 
screens.

5.1. Audio sources
In ZaraStudio, an audio source is a repository of audio files. In the audio explorer, each audio 
source corresponds to a tab. There are two types of audio sources: database audio sources 

(represented  by  the  icon  )  and  disk  audio  sources  (represented  by  the  icon  ).  Let’s 
assume an audio explorer that looks like this:
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We would have four audio sources in this case: two database audio sources (DB and DB 2) and 
two disk audio sources (Music and Radio).

5.2. Database audio sources
A database audio source is  that,  as its  name suggests,  it  is  managed through ZaraStudio's 
database, allowing you to add specific information about each audio and assign a number of 
marks.

Note that the database only stores the audio list and their associated properties (title, player,  
marks,...). The actual audio files are stored in a standard system folder specific for each audio 
source, which can be located in the PC hard drive or in a network shared folder.

This audio source type is specifically recommended to manage the station music catalog, as 
well as audios that will be used frequently.

5.2.1. Create, edit and delete audio sources

In order to create, modify or delete these audio sources, you have to press the button  in 
the explorer tool bar. Doing that will open this window:

As you can see, it shows a list with all the available audio sources, as well as the location where  
their audio files are stored.
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To create a new audio source, just press the Add button, which opens the following dialog:

There, you have to type the name of the audio source, which will appear in the explorer tab,  
and the local or network folder where the audio files will be stored. In case you have several  
network terminals, we advise you to choose a network folder, as otherwise you will not be able 
to access to the audios from other computers.

Going back to the previous window, the Edit button opens the same dialog as the Add one to 
modify an existing audio source. Note that if you change the folder location, all the already  
created audio files will no longer be accesible.

The  Remove  button  deletes  an  existing  audio  source,  though,  as  a  precaution,  does  not 
physically delete the audio files.

5.2.2. Window controls

A database audio source looks like this in the explorer:
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It contains the following elements:

● A tool bar, which allows you to import audios, modify their properties, delete them 
and update their content.

● A search field, which enables you to look for a specific audio.

● A folder tree, which categorizes the audios.

● A list with the audios contained in the selected folder.

In more detail, the tool bar has the following buttons:

Imports new audio files to the source.
Edits the properties of the selected audio.
Remove the selected audio, as well as its associated file.
Updates the contents  of  the audio source,  displaying the changes made from other 
terminals.  This  button should  not  be  necessary,  as  ZaraStudio  automatically  detects 
changes and refreshes the audio sources when needed.
Syncs the database folder with the associated Windows folder, adding all new files and 
deleting those that no longer exist. 

11



User manual ZaraStudio

5.2.3. Folder creation

Before adding audios to the database, you have to create at least one folder. To do that, right-
click on the audio source tree root element, and choose New folder... in the context menu.

Doing that will open this window:

There, you will have to fill out the following folder attributes:

● Name: the name of the folder, which will be shown in the folder tree.

● Location: the name of the folder which will contain the one that is being created, 
that is, the parent folder. To choose a folder, press the Browse... button.

● Type: allows you to assign a type to the folder depending on the audios you plan to 
add. Therefore, all the newly created audios in this folder will have, by default, that 
audio type.

Once you have filled out those fields, press OK and the folder will appear in the audio explorer.

From the context menu, you can also access to the following functions:

● Delete folder: deletes an existing folder, as well as all its audios.
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● Shuffle play time: resets all the audios last play date and time. This is useful to modify 
the  rotation  of  this  folder  when using  random tracks,  specially  if  you  use  a  low 
random level.

● Properties: allows you to view and modify the attributes of an already created folder.

5.2.4. Audio import

The audio import is the process that allows you to add new audios to the database. It can be 
made in two different ways:

● By pressing the button  in the tool bar. Doing that, opens a dialog to choose the 
audios to import. You can select several files at a time using the Ctrl and Shift keys.

● By dragging files from the Windows explorer to the audio list.

Following either steps, the audio file is automatically copied to that folder assigned to the audio  
source and added to the database with default properties, which can be configured through 
the Options > Explorer window.

That  way,  if  ZaraStudio  is  configured to  read the audio files  tags,  the title,  author,  album,  
composer,  genre and year fields will  be filled out  automatically,  as  long as those data are  
included in the tags. Otherwise, the file name will be interpreted as “Author – Title”. If the file is 
not named following that convention, the whole name will be used as title.

Besides,  in  case  you  have  configured  this  in  the  Options  dialog,  ZaraStudio  will  try  to 
automatically detect the start, end and mix marks. If this option is not enabled, the marks will  
be read from the file name (using the ~ symbol, as explained previously).

5.2.5. Audio properties

To access to a specific audio properties,  just  double-click over it  or  select  it  and press the 

button  in the tool bar.

The properties  window will  display specific data depending on the audio type.  The data is 
grouped in several tabs.

5.2.5.1. Audio

The Audio tab enables you to enter the basic properties of a music track, like its title, author,  
album...
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You  have  to  pay  special  attention  to  the  Artist field,  as  it  will  be  used  in  random  music 
programmings to separate tracks from the same Artist.

5.2.5.2. Comments

It allows you to associate a long text with the audio, like, for example, a suggestion to present a 
song by a DJ.
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5.2.5.3. Marks

Apart from the marks that have been historically supported in the file name, audios stored in 
the database support an additional set of marks. They are accessed through the audio 
properties, selecting the Marks tab.
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They are the following:

● Start: point where playback will start. It is useful to skip silence at the beginning of a 
file.

● End: point where playback will stop. As with the previous mark, it is useful to skip 
silence at the end of the file.

● Intro: point where the interpreter starts to sing, in case of music audios. It can also 
be used for jingles that start with an instrumental background. It is useful to let the  
presenter know how much time it has to introduce the song.

● Outro: point where the interpreter stops singing.

● Fade in: increases audio level gradually from silence to the maximum level during 
the specified time interval.

● Fade out: decreases audio level gradually from maximum level to silence. The fade 
out starts when the mix out mark is reached.

● Mix out: point where the next audio will start.

● Mix in: point up to which this audio can be mixed with the previous one. This mark is 
only taken into account where the audio is directly inserted in the playlist. It is not 
taken into account, for example, if the audio is in a rotation file.
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● End type: it can be with or without fade. In case you choose without fade, the audio 
will be played until the end mark and will be cut.

As you may have noticed, each mark has a check box at the left. If it is not checked, the mark 
will have an undefined value. In that case, the default overlap and fade values will be used for 
the Mix out and Fade out marks and the Mix in mark will allow the audio to be mixed with the 
previous one with no limit.

5.2.5.4. Details

The Details tab displays various information about the audio, like the folder where it is located, 
the name of the associated file, the audio source path, the creation date, the last modification 
date, the last playback date and the expiration date.

The expiration date can be modified to indicate the date and time from which the audio will no 
longer be played, even if it is added to a player. The audio will no longer be chosen from 
random tracks either.

5.2.6. Folder synchronization

In addition to manual file import, ZaraStudio has a synchronization mechanism that allows you 
to sync the selected folder in the database with its associated folder in Windows. The program 
then  searches  for  new  files  that  have  been  copied  to  the  folder  and  imports  them 
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automatically. It also deletes files that may have been removed.

To import files using this method, go to the Windows folder associated with the database folder  
you wish to update. This can be done through the folder's context menu by selecting the Open 
in Explorer option: 

The associated folder will then open in Windows. Copy the new files you want to add to the  
database into it. Then, click the button. The following window will open: 

You will see a list of new files found under Files to Import, as well as another list of files that 
have been deleted under  Files to Delete.  You can individually  validate each file using the 
checkbox  on  its  left.  Files  that  are  not  validated  will  be  ignored.
Once the files are validated, click Import the selected audios to add the files to the database, 
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or Delete the selected audios to remove those that have been deleted.

5.2.7. Search

The database audio sources have a search field next to the tool bar. It allows you to quickly find 
any audio:

To perform a search, just type in the field the text you want to find and press Enter. That text 
will be looked up in the Title and Artist fields of every audio.

Clicking on the magnifying glass icon, pop-ups a menu that enables you to refine the search by 
specifying if you want to search in the current folder or in all the available folders.

5.3. Disk audio sources
A disk audio source takes files directly from hard disk folders without using a database. This  
option is similar to the file explorer included in previous versions. It has the advantage of being 
fast to set-up and easy to use, but it has limitations in random music programmings and it may 
have a poor performance on large folders.

5.3.1. Create, edit and delete audio sources

To create,  modify  or  delete  these audio sources,  you have to  press  the button   in  the 
explorer tool bar. Doing that opens this dialog:
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As you can see, it displays a list with all the available audio sources, as well as the folder they  
are pointing to.

To create a new audio source, just press the Add button, which opens the following dialog:

There, you have to enter the name of the audio source, which will be the one displayed in the 
explorer tabs, and the local or shared folder from which audio files will be taken.

Going back to the previous dialog, the Edit button opens the same dialog as Add, but it allows 
you to modify an existing audio source.

The Delete button enables you to delete an existing audio source, but, as a safety measure, it 
does not delete physically the audio files.

5.4. Window controls
A disk audio source looks like this in the explorer:
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It has the following items:

● A tool bar, which allows you to refresh the folder contents and look for specific files.

● The folders contained by the folder to which the audio source is pointing to.

● A list with the audios contained by the selected folder.

In more detail, the tool bar has the following buttons:

Opens the search tool.
Refreshes the folder contents,  displaying the changes made from other terminals or 
from Windows explorer.

 

5.4.1.1. Search in folders

The button  gives access to the search tool. Pressing it opens this window:
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By default,  it  will  perform the search on the audio source folder  and all  of  its  descending 
folders.

● Find: You have to write the text which will  be searched in this field. ZaraStudio will 
search in the file name and in the ID3 tags TITLE and ARTIST, as long as it is enabled the 
search in ID3 tags option. 

● Cancel: Cancels the current search. 

● Folder: Folder  in  which  the  search  will  be  done.  You  can  choose  one  by  pressing 
Browse. 

● Search in ID3 tags: Tells ZaraStudio whether the ID3 tags will be read or not. Please, 
note that the search is slower when this option is checked.

● Find now: Starts the search process. 

Once the search is finished, the list at the bottom will show all the files found. In order to insert  
them in the playlist, just make drag-and-drop. Besides, it is possible to prelisten the files by 
clicking with the right mouse button on the desired file and selecting the Cue option.
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6. The players
The  players  allows  you  to  broadcast  audios  through  the  specified  sound  card,  which  is 
configurable by accessing the options dialog. It contains several elements:

● The top tool bar.

● The audio state indicators.

● The playlist.

● The control buttons.

6.1. The tool bar

Displays a pop-up menu with the following options:
• New: Creates a new playlist and closes the previous one.
• Open: Opens a previously saved playlist (LST, ROT, SEQ...).
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• Open template: Allows to load a music style template in the 
player.  Songs  will  be  added  automatically  to  the  playlist 
following the template.

• Save: Saves the current playlist.
• Save as: Saves the current playlist with another name.

Opens a previously saved playlist (LST, ROT, SEQ...).

Saves the current playlist.

Allows you to add new audios to the list. The arrow at the right of the 
plus symbol opens a context menu, that lets you add commands to 
the playlist.

Deletes the selected elements.

Updates  the  durations  that  are  displayed  in  the  second  playlist 
column. This command is useful when the audios are modified and 
their duration changes.

Displays a pop-up menu with the following options:
• Find: Allows you to search audios in the playlist.
• Check: Scans through all the playlist items and checks if they 

exist on the hard disk.  If  there are files missing, it  tells you 
what files are and lets you delete them.

• Update lengths: Updates the durations that are displayed in 
the second playlist column. This command is useful when the 
audios are modified and their duration changes.

• Shuffle: Rearranges the playlist randomly.

Changes the playing mode. It can be Manual, Normal, Repeat, Random 
or Shuffle. See the playlist section for more details.

6.2. State indicators

● Remaining time (left  clock).  Shows the time left  until  the audio which is 
being played finishes.

● Vumeter. Shows the audio level.

● List remaining time (right clock). It shows the combined duration of all the 
audios in the list that have not yet been played, meaning the remaining time 
of the segment marked in red plus the duration of all  the following tracks. 
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Please note that this is an approximate time, as it does not account for certain 
files,  such as rotations or  random tracks,  whose duration is  not  known in 
advance.  However,  the  mixing  times  between  the  audios  are  taken  into 
account.

● Position bar. Displays the percentage of the audio that has been played. It 
can be moved with the mouse to play an exact part of the file.

● List length. Displays the length of all the files in the playlist. Please, note that 
this is not an accurate data, as it does not consider the overlap between cuts 
nor the length of certain files, like rotations or random tracks.

● Title of the audio currently playing (on air). It indicates the title of the audio 
playing in the list, which matches the one highlighted in red.

● Title and time of the next audio. Below the currently playing title, you can 
see the title of the next audio to be played, which matches the one highlighted 
in green in the list. To the left, in a green background, is the time at which the 
audio will start.

6.3. The playlist

The playlist is the main element of ZaraStudio. It shows the sequence of sound files and/or 
commands which are played or executed one by one. The elements that can appear in the list  
are: 

● Sound Files. Currently, ZaraStudio supports the following formats:

 WAV. Losless and uncompressed audio format.

 MP2.  Sound format that  produces better  quality  than MP3 when using high 
bitrates  (more  than  256  kbps).  This  is  the  standard  format  in  broadcasting, 
though is losing ground in favor of MP3.

 MP3.  Popular  audio  format  for  home  use.  ZaraStudio  accepts  any  bit-rate 
(constant bit-rate or variable).  When using constant bitrates, it is advised to use 
a minimum of 192 kbps, being recommendable to use 256 kbps to get a perfect 
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broadcast audio quality.

 OGG. A free sound file, alternative to MP3.

 WMA. A Windows Media sound file. It is also an alternative to MP3.

 FLAC. Losless audio format, as WAV files. However, it does compress the audio, 
so it produces smaller files than WAV, though it does not compress as much as 
MP3.

 M4A. AAC and AAC+ audio formats.

● Database audios (.db files). This item references an audio in the database. It is played 
as a regular audio file, but it supports additional marks.

● Playlists (.lst, .m3u and .pls files). This file is a command when it appears inside a list. 
Its purpose is to load a new list and close the previous one. The new list will begin to 
play,  beginning  with  the  first  song.  PLS  lists  remember  the  latest  file  played  when 
opening them.

These three formats are the same for ZaraStudio. The only slightly 
different one is PLS, as it remembers the last played song after opening 
the list. This feature is useful to change the musical programming at a 
certain time, by scheduling a file of one of these formats through an 
event.

● Rotations (.rot files). A list of sound files in rotation. It contains a list of tracks which 
play in the sequence as created. The tracks repeat in sequence. If a file in the list fails to  
play, the sequence will continue to the next file (failures noted in log file). The rotation 
file can contain any type of track (wav, mp3, commands, rotations...). 

● Sequences (.seq files). Sequences sound files. It contains a list of tracks that play all 
followed when playing the sequence. Like the rotations, the sequences can contain any 
type of tracks. They can be used to program advertising blocks. 

● Templates (.tpl files). Contain the definition of a music style based on random tracks. 
When a template is loaded, ZaraStudio adds audios to the playlist automatically as the 
player approaches to the end, following the guidelines specified by the template, so that 
there are always at least 15 audio minutes left to play.

● Stop command (.stop files). Command that stops the playback.

● Play command (.play files). Starts the playlist. It only makes sense as an immediate 
event.

● Humidity files (.humidity). A sound file that says the humidity. In order to carry out 
this task, it is necessary to have the files with the proper name format in the Humidity 
directory, located in the folder where ZaraStudio is installed. The format of the files  
must  be  HUMXXX.mp3,  where  XXX is  the  corresponding  humidity.  For  example, 
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HUM100.mp3 is an audio clip that states: “the current humidity is 100%”.

● Temperature files (.temperature). A sound file that says the temperature. In order to 
carry out this task, it is necessary to have the files with the proper name format in the 
Temperature directory, located in the folder where ZaraStudio is installed. The format 
of the files must be:

 TMPXXX.mp3. This is a file that contains the audio clip for temperature XXX. For 
example, TMP025.mp3 is an audio clip that will say “25 degrees”.

 TMPNXXX.mp3. This is a file that contains the audio clip for temperature  XXX 
below zero. For example, TMPN003.mp3 is an audio clip that will say “3 degrees 
below zero”.

● Time announcements (.time files).  A sound file that says the time. Audio clips for 
hours and minutes must be properly located in the Time folder. The name of the files  
must be:

1. MINXX.mp3.  This is an audio clip of minute  XX.  For example,  MIN01.mp3 will 
contain and audio that will say “one”.

2. HRSXX.mp3.  This  is  an  audio  clip  of  hour  XX.  For  example,  HRS18.mp3 will 
contain and audio that will say “it's eighteen hours”.

3. HRSXX_O.MP3.  This  is  an  audio  clip  of  hour  XX o'clock.  For  example, 
HRS18_O.MP3 will contain and audio that will say “it's six o'clock”.

● Pauses (.pause files). When playing, they cause a silence of a determined length. In 
order to create pauses it is necessary to execute the command playlist > Add pause.... 
Its duration must be specified between 0 and 3600 seconds.

● Random  tracks  (.dir  files).  When  played,  a  track  is  selected  at  random  from  the 
directory  or  sub-directory  thereof  specified.  Random tracks  have a  system to avoid 
repetitions (see Options – Random tracks for more details). In order to create random 
tracks it is necessary to execute the command Playlist > Add random track..., which is 

in the pop up menu of the button  from each player. If new files are added to the 
specified directory, they are automatically added to the random list.

This feature is useful to create random music programmings. A list in 
repeat mode can be created with several random tracks, that will define 
the random programming template.

It is recommended to use this feature only in local folders in the computer 
which ZaraStudio is being executed, avoiding folders placed in other 
machines of the local network. Besides, it is not advisable to use this 
function with folders that contain a big amount of files, as this will slow 
down the audio pick up process.
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● Database random tracks (.dbr files). When played, a track is selected at random from 
the selected database folder (subfolders are not included).  Database random tracks 
also  have  a  system  to  avoid  repetitions.  To  create  a  database  random  track,  it  is 
necessary to execute the command Playlist > Add database random track..., which is 

in the pop up menu of the button  from each player.

Database random tracks are also suitable to play them from network folders.

● Post-it  (.txt,  .htm  and  .html  files).  Command  that  opens  a  window,  showing  the 
contents of the text or HTML file.

● Executables and scripts (.exe y .bat files). Command that runs the exe or bat file. 

● Load events command (.evt command). Loading another event file clears the current 
event list replacing it with events specified by the event file loaded. 

● On-line radios (.stream files). Plays the sound of an on-line radio station.

● Satellite connections (.satcon files). Enables the line in of the sound card specified in 
the options dialog.

● Satellite disconnections (.satdis files). Mutes the line in of the sound card specified in 
the options dialog.

● Relay pulse (.relaypulse files). It generates a 100 ms pulse on pin 4 of the parallel port. 
This  pulse  can  be  useful  for  controlling  an  external  device  or  signaling  a  local 
disconnection. 

● Virtual  relay  open  command  (.iprelayopen  files). It  sends  a  TCP/IP  frame  to  all 
configured servers, signaling the opening of the specified virtual relay. It is typically used 
as a remote control to signal the completion of a local disconnection via IP.

● Virtual  relay  close  command  (.iprelayclose  files). It  sends  a  TCP/IP  frame  to  all 
configured servers, signaling the closing of the specified virtual relay. It is typically used 
as a remote control to signal the beginning of a local disconnection via IP.

● Enable the DTMF detector (.dtmfon files). Enables the DTMF tone detector.

● Disabled the DTMF detector (.dtmfoff files). Disables the DTMF tone detector.

● Enable LPT control (.lpton files). Enables remote control through the parallel port.

● Disable LPT control (.lptoff files). Disables remote control through the parallel port.

● Enable serial port control (.comon files). Enables remote control through serial port.

● Disable  serial  port  control  (.comoff files).  Disables  remote  control  through serial 
port.
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● IP  control  activation  command  (.ipon  files).  Activates  remote  control  via  IP 
commands.

● IP  control  deactivation  command  (.ipoff files).  Deactivates  remote  control  via  IP 
commands.

● Enable voice tracking (.enablesweepers files). Enables voice tracking.

● Disable voice tracking (.disablesweepers files). Disables voice tracking.

6.3.1. How to create a new list

1. Press  and select New in the pop-up menu to create an empty list.

2. In order to add items to the list, press   on the tool bar. This will open a window 
from which files can be selected. Standard Windows operations are allowed here for 
selecting  more than one file  at  a  time by using either  the  Ctrl or  Shift key.  When 
pressing the arrow next to the button, a context menu is displayed, that allows to insert 
commands into the playlist.

As an alternative, you can also insert audios by dragging files from the directory tree 
below the events list or from any other Windows explorer window. For that, select a file 
with the mouse and, without releasing the mouse button, drag it to the playlist.

6.3.2. Playlist operation

● When the list is in STOP, there is always a track of green color. The green color indicates 
which track is going to be played next. Therefore, pressing PLAY, the track marked in 
green color will play. 

● When the list is in PLAY, there is a track marked red in color. That is the track currently  
playing. As above, the track green in color will be next. 

At any time you can change which track will be next. To do this, double-click on a track (unless 
the option is activated to play immediately with double-click, in which case it is necessary to 
open the Media menu to make the change). Otherwise, you can right-click on the track with the  
mouse and select Mark as next. This way, the track will be in green color, indicating that it will  

play next. Clicking on  will stop the playlist after the current track (colored red) is finished. 

6.3.3. How to save the list

It is possible to store the list in a file, to open it back again later. To do that, press the button  

 and select the Save option in the pop-up menu. Then choose the name you want for the 
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list, as well as its type (LST, PLS, M3U...). If you want to save the list with another name or type,  
then execute the option File > Save as... for the main player or the command with the same 
name for the auxiliary players context menu.

Besides, keep in mind that the lists created on a computer don't work on another one, unless 
network paths are used rather than local ones.

6.3.4. Playlist operation modes

The playlist can operate five different ways. These are selected from the drop-down box in the 
tool bar.

● Normal: The list plays sequentially and stops when the last track has finished.

● Repeat: The list plays sequentially and restarts after the last track has finished.

● Shuffle: Same as repeat, except it randomly rearranges the list before playing it again.

● Manual: The selected song plays once and it stops when finished.

● Random: It plays the list in random order, that is to say, the green marker moves to a  
track randomly and plays it.  It does not ensure that the tracks are not repeated. 
Therefore, it is not recommended for random music programmings.

6.3.5. Context menu

The playlist has a pop up menu, which opens by right-clicking the mouse on the playlist. This is 
basically a short cut to commonly used items from the menu bar and tool bars. Simultaneously,  
the track that is right-clicked is selected for the action selected in the Pop-Up menu. You can 
access the following functions through this menu:

● Mark as next:  It  marks the selected audio in green,  so that it  will  be the next cut 
played.

● Play: It starts playback with the selected audio. If another cut was being played in that 
moment, it stops it.

● Rename: It lets you change the name of the selected file in the playlist.

● Set voice track...: It assigns a voice track to the selected audio.

● Remove voice track: Removes the voice track associated with selected audio.

● Cue: It allows you to prelisten the selected audio without broadcasting it. To use this 
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function you need two sound cards.

● View selection length:  Opens a dialog that displays the total length of the selected 
audios.

● Show start time: Displays an additional column in the list with the start time of each 
audio. 

● Copy: Copies the selected audios into the clipboard.

● Paste: Pastes in the playlist the audios contained in the clipboard.

● Delete: Removes the selected audios from the playlist.

● Delete all: Empties the playlist.

6.4. Control buttons
Below the playlist are the buttons that allow you to control it. It is also possible to make them 

appear at the top of the player along with the other indicators. To do this, press the   
button on the top bar and select the Buttons up option.

The available control buttons are as follows:

PLAY  button.  Sets  ZaraStudio  in  PLAY  mode,  beginning  by  the  green 
colored audio.

STOP button. Stops the playlist.

PAUSE  button.  Pauses  the  playlist.  This  button  does  not  work  with 
satellite commands.

STOP + PLAY button.  Stops the current audio and plays the next one 
(green colored).

REWIND button. Moves the playback 30 seconds backward.

FORWARD button. Moves the playback 30 seconds forward.

STOP  AFTER  CURRENT  button.  Stops  playback  after  the  current  item 
finishes.

TALK OVER button. Reduces the playback volume, and restores it when 
the button is pressed again. The amount of change in playback volume is 

31



User manual ZaraStudio

set in the options menu as is the time to fade the playback to that level. 
Look for Talk Over in the options.

LOOP button. Plays the current audio continuously,  that is,  when it  is 
finished it  is  played again from the beginning.  This  happens until  this 
button is unchecked or the Stop + Play button is pressed.

AUTODELETE button. When it is pressed, ZaraStudio removes each audio 
from the playlist, just after playing it.

Besides, the track bar which is at the right of the buttons allows to change the 
audio level of the playlist.

6.5. File attributes
Despite not having a database, ZaraStudio can store certain information about audios in the file  
name. Such data are:

● Overlap. The end of each audio can be overlapped with the beginning of the next 
one  for  a  customizable  time  interval  for  each  cut.  This  is  done  by  adding 
“~overlap” at the end of the file name. However, remember that this period is only 
considered exactly when the end of the song detector is disabled (see Options – 
Fade). Here, there are several examples:

 A file called Id~0.mp3 would be overlapped zero seconds with the next one.

 A file called Song~8.mp3 would be overlapped for eight seconds with the next 
one.

● Audio  start. Some  files  may  have  several  silence  seconds  at  the  beginning, 
especially songs ripped from CDs. In order to jump directly to the audio beginning, 
you should add “~start-” to the file name. Besides, you can set the overlap and the 
start  simultaneously,  by  typing  the  suffix  “~start-overlap”.  Here,  you  can  see 
several examples:

 A file called Song~4-.mp3 would be played skipping the first four seconds.

 Another file named  Song~4-9.mp3 would be played skipping the first four 
seconds and it would be overlapped nine seconds with the next cut in the list.

● Intro time. Intro time is the period that goes from the beginning of the audio file 
until the singer starts singing. In order to set this time, you have to add “~intro-
start-overlap” to the file name. As you can see, when an intro time is added is  
mandatory to also set the overlap and start points, though you can leave them 
empty to use the default values. See the following examples:

 A  file  named  Song~4-1-10.mp3 would  be  played  skipping  the  first  audio 
second, with an intro period of four seconds and overlapping ten seconds with 
the next audio cut.
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 A file named Song~4--.mp3 would be played with a four-second intro period 
and with the default overlap and start values.

● Expiration date. Some audios, like ads, may have an expiration date, from which 
the file mustn't be played. In these cases, you can set this date in the file name.  
This way, ZaraStudio won't play expired files and it will indicate this situation in 
the log file. Besides, when an expired file is placed into a folder and that folder is 
played as a random track,  the file is  not considered.  expired cuts in rotations 
aren't played either. The date must be typed in the format [dd-mm-yyyy], since, if 
it is not exactly in this way, it won't be considered or it will behave unpredictably. 
Here, there are some examples:

 A  file  called  shopAd  [12-11-2008].mp3 would  expire  on  the  12th  of 
November, 2008. That day, it wouldn't be played.

 A file called Christmas [07-01-2009]~2-1.mp3 would expire on the 7th of 
January, 2009, it would be overlapped for a second with the next cut and it 
would be skipped the first two seconds.

7. Events
An event is a file that activates on schedule. Events are a useful way to play files or to execute  
commands independent of the playlist. They can be used to program announcements, actions, 
etc. 

From version 3, events are played from an independent player. This way, audios are played 
from the main player and, when the time of an event is reached, the main player is stopped 
and the event player activates. Once the scheduled events have been played, the main player 
activates again.
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This figure shows the event player. The playlist contains all the pending events that are going to  
be played today. As they are played, they are automatically removed from the playlist. At 23:45  
(11:45 PM), tomorrow's events are inserted at the end of the playlist.

Events may come from two different sources:

● From the events programming dialog.

● From the commercial  schedule.  This  schedule can be generated with an external 
application, like ZaraTraffic, or with the Schedule editor, which can be accessed from 
the Tools > Schedule editor menu option. There can be a different schedule for each 
week day, as well  as for specific dates. First,  ZaraStudio will  try to load a specific 
schedule for the current date.  If  the schedule does not exist,  it  will  try to load a 
generic schedule for the current week day.

This  way,  events  from those  two sources  are  merged  and displayed  in  the  events  player.  
Besides, the user can modify them at any time, as if it were a regular player.
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7.1. The tool bar
The tool bar of the events player is similar to the one in the regular players, except the first 
three buttons, whose functions are the following:

Opens a dialog that allows you to create new events, as well as modifying or 
viewing existing ones.

Reloads the event list, reflecting the changes that might have been done from 
other network terminals. Take into account that changes made directly on the 
player will be lost.

Removes the events whose air time has already passed.

Changes the playback mode. It can be Manual,  Auto+List, or Auto+Sat. When 
the  player  is  in  manual  mode,  no  events  are  triggered  without  user 
intervention, while in automatic mode, events are triggered as their scheduled 
time arrives. If the  Auto+List mode is selected, the application will switch to 
play the main player once the events are finished; on the other hand, if the 
selected mode is Auto+Sat, it will connect to the satellite signal.

7.2. Event programming dialog

As previously stated, the event programming dialog is acceded through the  tool bar button. 
When you click on that button, the following window opens:
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Each event has a check box that serves to activate or to deactivate the events individually.  
Changes done will be saved and the dialog will close when pressing the OK button.

7.2.1. New

Now, to add a new event, just press the  Add event button. Then, we will see the following 
dialog:
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The user defined parameters of an event are: 

● Description

Allows you to give a name to the event, which will be displayed in the general event list  
window. If this field is left empty, the event name will be the same as the name of the  
file selected as the event's content.

● Tab

Name of the tab in the event dialog to which this new event will be assigned.

● Duration

Desired duration for the event. It is used only for informational purposes for the user.

● Date and time

Select the date and time at which the event will play for the first time. The event will  
remain active until the date and time of expiration. If the expiration check box is not 
checked (default), then the event won't expire.

● Days

Allows you to configure the days of the week when the event will be active.
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● Periodicity

Setting date and time defaults to playing once per day. Selecting Play every hour will 
do just that. Also, it is possible to program the event to play at selected hours. Selecting 
... opens the following window:

Here you can mark the hours desired. For any of the times (hours) selected, the minutes 
default to whatever was selected for the start time. 

● Event type

This can be a sound file, but also we can activate play or stop automatically, insert a 
random track, a connection via satellite... Through this dropdown, you can select the 
desired event type. Special mention goes to the Block type, which allows scheduling 
multiple  audio  files  to  be  played  in  sequence  through  a  single  event.  For  more 
information, please refer to the playlist section.

● Start type

An event can be delayed, immediate or overlapped. Let's see how it behaves on each 
case:

 Delayed.  The event is not played when its start time arrives, instead it waits 
until the song that is being played ends. If the program is stopped, the event will  
remain in wait until it is launched manually.

 Immediate. The event is played at its exact time. If another file is being played, 
it will be stopped. On the other hand, if the program is not playing any file, the  
event will be played too.

 Overlapped.  The event  is  played over  the file  which is  being played in that 
moment, reducing its volume to hear the event clearly. This is configurable in 
the Talk Over page of the options dialog.

 Telecommand.  Once  its  start  time  is  reached,  the  event  waits  until  a 
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telecommand is received, either by DTMF tones, parallel port or serial port.

● Maximum wait

Maximum wait specifies how long an event can be delayed before being removed from 
the list of events. For example, if a delayed event programmed to start at 13:15 has a  
maximum wait of 5 minutes and cannot start by 13:20, it disappears from the window 
of next events and it does not play this time. 

7.2.2. Modify

Click to modify one or more parameters of an event. It is necessary to have previously selected  
an event in the list. The same action can be carried out by double-clicking on an event. 

7.2.3. Delete

Click to delete one or several events. In order to select several events, hold the Ctrl key while 
events are selected at random with the mouse. In order to select a block of events, click on an 
event and while holding the Shift key, select the last event in the desired list. 

7.2.4. Delete expired

Events that have expired appear grayed out to indicate this fact. Clicking on Delete expired will 
clear all expired events from the list. 

7.2.5. Open/Save

These  two  buttons  are  to  open  existing  event  files  or  to  save  the  displayed  event  list  
respectively.  In  any  case,  when  closing  ZaraStudio  the  current  list  of  events  is  stored 
automatically by Windows in the registry and is restored when ZaraStudio is restarted. 

7.2.6. New tab

This button opens a dialog in which you must specify the name of the new tab. After typing it, a 
new tab will appear at the right of the last one. If there is no enough space in the window to  
display it, two small arrows will be displayed to navigate through the tabs. Events are always  
created in the active tab. However, it is possible to move them from one tab to another. Simply,  
right-click over the desired event and select the Cut command. Then, go to the destination tab, 
press the right mouse button again and choose the Paste command.

Tabs are useful to group events by themes, avoiding a large events list. This way you can, for  
example, create a new tab called “Id”, another one for “ads”,...
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7.2.7. Remove tab

A dialog will appear when pressing this button. It will ask you if you are sure you want to delete  
the tab, because, when doing it, all the events it contains will be deleted too.

7.2.8. Context menus

The events dialog has two context menus, which allows you to access to several additional 
features.

● List context menu. If you press with the right button of the mouse on the events list, a 
pop-up menu will appear, that will allow you to make the typical edit operations: copy, 
paste, cut, remove and remove all.

● Tabs context menu. This menu is opened by clicking with the right mouse button on 
the active tab. You can create a new tab, remove the current one or rename it.

7.3. Schedule editor
As previously stated, events can come from two different sources: the events programming 
dialog, whose use has been described in the previous section, and today's advertising schedule 
(though its use it is not limited to advertising). In this section, we will cover the second option.

When ZaraStudio loads at 23:45 tomorrow's events, it also tries to load the advertising schedule 
for that day. That schedule can be specific for that day or a generic one for the corresponding 
weekday. Schedules for specific dates have more priority and the generic ones are only loaded 
when the former does not exist.

In order to edit a schedule, click on the  button and select Schedule editor on the pop-
up menu. Doing that opens this window:

40



User manual ZaraStudio

When it opens, it displays today's advertising schedule. The loaded day can be seen in the title 
bar.

It works almost in the same way as a regular player. The only difference is that it does not have  
playback controls. However, the open and save buttons are slightly different, as they allow you 
to choose dates or weekdays instead of files. 

Another difference is that items are grouped in blocks in the same way as in the events player 
and they are highlighted in gray. In the Duration column, the total time of all the audio files in 
the block is displayed, taking into account any mix times if applicable, and, in parentheses, the 
remaining time to complete the configured duration for the block. If the block time has been 
exceeded, the Duration box will appear in red.

7.3.1. How to open and save schedules

To open a schedule, just press the  button on the tool bar. Doing that, opens this dialog:
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There, you can select if you want to open a schedule for a specific date, by checking the  By 
date option, or a generic one for a specific weekday, by checking the By weekday option.

Depending on the selected option, you will have to select a date in a calendar or a weekday in 
the corresponding drop-down field. To facilitate loading by date, the calendar displays in bold 
the dates for which there is already a schedule.

Pressing  OK will open the selected schedule. In case there is not a schedule for that date, a 
blank schedule will appear.

Once you have edited the schedule, you can save it by pressing the  button. Additionally, it 

can also be assigned to a different day using the Save as... option, found in the  menu or in 
the context menu of the list, accessed by right-clicking. When doing this, a dialog similar to the 
open dialog appears, allowing us to select the day on which we want to save the schedule.

If we want to save the current schedule on multiple days at once, we will press the  button 
and then select the Save a copy... option.
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Doing so will open a new window that allows us to choose the date range in which we want to 
save the schedule:
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Here, we have two options: 

● Days of the week: if we simply want to save the schedule on multiple days of the week, 
we select the desired days and press OK.

● Date range: if, on the other hand, we want to save the schedule by date, we choose the  
date range in which we want to save the schedule. Additionally, we will also select the 
days  of  the  week within  that  date  range on which  the  schedule  will  be  saved.  For 
example, if we wanted to save the schedule on every Monday in June 2025, we would 
select 01/06/2025 as the start date, 30/06/2025 as the end date, and Monday as the day 
of the week.

7.3.2. Editing schedules

You can edit a schedule in the same way as a regular playlist. Therefore, you can add audios by 

pressing  the   tool  bar  button or  by  dragging  them from the  audio  explorer  or  from a 
Windows explorer window.

7.3.3. Creating, editing and deleting blocks

To create a block, just press the  tool bar button or select Add block... in the context menu. 
After doing that, the following dialog will appear:

This dialog allows you to set the block options, which are the same as for a conventional event: 
play time, block type, repetition and maximum wait. After setting those options, press OK and 
the block will be displayed on the list. It is also possible to assign a name to the event through 
the  Description field and specify the desired duration through the  Duration field. When a 
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duration is configured, the block shows the remaining time to be filled in the block to reach the  
desired duration. This is especially useful when scheduling local ad disconnections for stations 
affiliated with networks.

After configuring these options and pressing OK, the block is automatically created in the list, 
occupying the position that corresponds to the chosen schedule. If  Every hour is selected in 
the Repetition dropdown, a block will be inserted every hour, with the minutes and seconds 
matching those set in the Time field.

Once the block is created, you can modify its options by right-clicking on it and selecting Edit 
block.... Doing that will open a window to edit its parameters.

Besides, you can also delete an existing block and all its audios by selecting Delete block in the 
context menu.

Finally, sometimes you may want to create two blocks with different times but with the same 
contents. To faciliatate that, you can select the Copy block... option, which creates a new block 
with the same contents as the selected block.

7.3.4. Programming audios in blocks

It is common to have to schedule an audio, like a commercial, several times a day. To facilitate 
that task, the schedule editor provides two tools, which can be accessed through the playlist  
context menu: Schedule…, Schedule every… and Schedule in period….

7.3.4.1. Schedule

The Schedule... option allows you to select the blocks in which a certain audio must be placed. 
To use this tool, select an audio in the schedule, right-click on it and select Schedule... in the 
context menu. Doing that, will open this dialog:
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There, you have to check the blocks in which you want to place the audio. Then, you will have to 
choose the position the audio will occupy in the block: at the beginning, at the end or in a fixed 
position (1 to place it at the beginning, 2 to place it in the second position,...). If a block contains 
less audios than the selected position, it will be inserted at the end.

7.3.4.2. Schedule every

The Schedule every... option is similar to the previous one, but allows you to choose the blocks 
in a different way. In this case, the time of the block containing the selected audio will be taken 
as a reference and the audio will be inserted in the following blocks, taking into account the 
given separation and end time.
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For example, if an audio in a block at 13:00:00 is scheduled with a 120 minutes interval until  
19:00:00, it will be inserted in the blocks at 15:00:00, 17:00:00 and 19:00:00. If some of those  
blocks does not exist, it will be skipped.

7.3.5. Schedule in period

Unlike the previous options, which allow scheduling an audio file in multiple blocks on a single 
day, this command enables scheduling the selected audio in its current block over a given date 
range. Accessing this function opens the following dialog:
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In this dialog, the following fields must be completed:

● Start Date: The day the audio scheduling begins. 

● End Date: The last day the audio will be scheduled. 

● Position: The position where the audio will be placed within the block. 

● Block Creation: Specifies what to do if the block does not exist on a given day: 

 Copy the schedule from the weekday template: Copies the blocks (excluding 
any audio files) from the block template for the corresponding day of the week. 

 Create  the  block  if  it  doesn't  exist:  Creates  only  the  necessary  block  for 
scheduling the audio, without creating additional blocks. 

If neither option is selected, the audio will not be scheduled if the block does not exist.

7.3.5.1. Unschedule

In some occasions, it may be useful to remove all the occurrences of an audio in the schedule, 
for example, if a client wants to cancel a campaign and we have to remove all its commercials.  
To facilitate that task, you can select the audio, right-click on it and select Unschedule. That will 
remove all the occurrences of the audio in the opened schedule.

7.3.5.2. Unschedule in period

This function serves the same purpose as the previous one, except that it removes the audio 
from all blocks within a given date range.

7.4. Command scheduler
Sometimes,  it  is  necessary  to  enable  and  disable  the  reception  of  remote  commands 
automatically.  For  instance,  a  station  may  not  want  to  receive  these  commands  during  a 
specific time range because it  is  broadcasting local  programming.  The command scheduler 
allows  these  actions  to  be  carried  out  without  interrupting  the  broadcast.  The  command 
scheduler features an interface similar to the conventional event scheduler.

8. Options

Clicking on the icon  on the button bar, will open the options dialog. From this dialog, you 
will be able to manage:
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● Players

 Main

 Events

 Aux 1 to 4

 Cue

 Jingles

 Recorder

 Time signal

● Audio

 Satellite

 AGC

 Silence detector

 Mixer

● Telecommand

 DTMF

 Parallel port

 Serial port

 USB

 IP

 D&R Airence mixer

 D&R Airlite mixer

● General

 Database

 Log
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 Explorer

 Random tracks

 Tags

 Talk over

 Weather

 Folders

 RDS

 General

50



User manual ZaraStudio

Players

8.1.1. Main, events and auxiliaries

It allows you to set the crossfade parameters and the output device for each player:

● Crossfade. Indicates how audios in the player will be linked during playback.

 Overlap.  Specifies how many seconds will be played simultaneously the audio 
ending and the next one in the playlist.

 Fade. Indicates fades duration. Fade will start at the overlap point.

 Fade on overlap. When this option is active, ZaraStudio will fade the previous 
song whenever a new one begins. When deactivated, the song overlaps but is not  
faded. 

 Fade on stop. When activated, ZaraStudio will fade the playing track when Stop 
or Next is clicked. Otherwise, playback simply stops.
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 Detect the end of the songs. When this option is enabled, crossfade is not made 
until  the current playing audio level falls below the threshold indicated in the 
sliding bar. However, to achieve better mixes, it is recommended to manually set 
the overlap points for each audio or use the ZaraOverlap application.

● Output device: Indicates the sound card to use in the player.

By default, the value selected for overlapping applies to all tracks. Nevertheless, it is possible to 
give a specific value of overlapping to each song. The file must be renamed by adding ~overlap  
to the file name, where overlap is a positive integer or a float value. For example, in the file 
Blues~1.mp3, one second will be the overlap value. When writing decimal values, make sure 
you are using the decimal symbol specified in your Windows configuration, otherwise it won't 
be  recognized  (Control  Panel  >  Regional  Configuration  of  language  >  Standard  and 
formats > Personalize). 

Remember that you can set a different overlap in each file. To do that, you only 
have to rename the file, adding at the end of its name the character ~, followed 
by the seconds you want the overlap to last. For example, the file 
jingle~1.mp3 will be overlapped for a second with the next audio.

8.1.2. Cue and jingles
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It allows you to select the sound card to use for Cue and for the bottom bar jingles.

8.1.3. Recorder

It enables you to configure the recording tool, which is accessed with the  button. You 
can set the following parameters:

● Devices.

 Output device.  Specifies the sound card used for audio playback to prelisten 
your recordings.

 Input device. Indicates the sound card used as recording input.

● Format. It allows you to choose the audio quality used for recording. We recommend 
a minimum sampling frequency of 44100 Hz. for broadcast quality.
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8.1.4. Time signals

Allows configuring the broadcast of time signals, such as the classic pips (formally known as  
Greenwich Time Signal) that sound on the hour and at the half-hour:

● Output device: The card through which the chimes will be played. 
● Time signals on the hour: Plays the chimes at :59:55 so they end exactly on the hour. 
● Time signals at the half-hour: Plays the chimes at :29:55 so they end exactly at the 

half-hour. 

8.2. Audio

8.2.1. Satellite
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ZaraStudio allows rebroadcasting audio from the line-in input of up to two sound cards. The 
audio can be directed to the output of the event player (using connection and disconnection 
commands or the audio connector buttons in the main window's toolbar) or to the output of  
the active player when using timer-based connections.

Up to 10 satellite signals can be rebroadcast simultaneously, each from a different device or 
audio source, such as the line-in input, a streaming signal, or a D&R Airlite mixer.

The configuration fields include:

● Channel: The channel number to configure (1 to 10). 

● Name: The name of the station to rebroadcast. 

● Input type: Options include: 

 Record from device: The application rebroadcasts the sound from the line-in 
input of the selected sound card. ZaraStudio records the input signal, stores it in 
a buffer, and plays it through the output card. The buffer size is adjustable via 
the  Recording  buffer  size field  (in  milliseconds).  A  larger  buffer  reduces  the 
chance of dropouts but increases signal delay. 
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 Control the Windows mixer (listen to this device): Rebroadcasts the line-in 
signal  via  Windows,  with  the  advantage  that  the  audio  continues  even  if 
ZaraStudio closes. It offers lower delay but requires Windows configuration and 
doesn't support DTMF tone detection. 

To configure Windows, open the sound mixer via ZaraStudio, by pressing , 
or the Control Panel. 

In the Recording tab, right-click the device connected to the input signal, select 
Properties,  then navigate to the  Listen tab.  Enable  Listen to this  device and 
select the output card. 
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 Control the Windows mixer via hardware: Rebroadcasts the line-in input via 
the  sound  card's  hardware  controller.  This  option  has  zero  delay  but  is 
supported by very few sound cards. The signal can only be rebroadcast through 
the same card as the input. 

 Control an Airlite mixer: Rebroadcasts an external signal via the D&R Airlite 
mixer.  When  connected  via  USB,  ZaraStudio  can  control  the  mixer  and 
automatically activate the satellite signal's input channel. This method doesn't 
support DTMF tones or show VU meters in ZaraStudio but continues functioning 
even if the computer shuts down. 

 Internet radio: Rebroadcasts a streaming signal using protocols like Shoutcast, 
Icecast, or HLS. If the streaming connection is lost due to an internet or server 
issue, ZaraStudio will attempt to reconnect automatically. The retry interval is 
configurable via the Stream reconnection time field. 
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8.2.2. AGC

ZaraStudio  has  its  own automatic  gain  control  DSP  (AGC),  that  allows  to  level  equally  the 
volume of all audio files automatically, providing your broadcast a more or less constant audio 
level.

If you want ZaraStudio to level the sound, check the Enable AGC option and configure it at your  
taste. These are the modifiable parameters: 

● Output level: can take values between 0,0 (silence)  and 1,0 (0 dbs).  This  control 
allows to set the volume at which files will be normalized.

● Quiet level: audio level under silence is considered. ZaraStudio won't amplify the 
sound under this level.

● Rate: amplification adjustment rate.

● Gain: amplification level.

● Delay: delay in seconds before increasing level.

58



User manual ZaraStudio

Please, note that some extreme values may cause noises in the sound. If you prefer, you can  
use one of the three predefined presets. You can access them through the box which is on top 
of the sliders.

8.2.3. Silence detector

This  feature  allows ZaraStudio  to  detect  periods  of  silence  in  songs.  When such silence  is 
detected, the program skips to the next track. Note that this is only useful for poorly recorded 
tracks with silences, which should ideally never be played on air. It can also be helpful in case of  
malfunctions in the sound card used for broadcasting. However, it cannot detect a computer  
failure or system crash.

From version 4 onwards, ZaraStudio can also detect silence in satellite signals, which might 
occur due to adverse weather conditions or issues with a streaming signal. When silence is 
detected, ZaraStudio attempts to switch to the next satellite signal, where a backup of the main 
signal can be configured. For example, in the case of rebroadcasting a national network, the 
satellite configuration might look like this:

● Channel 1: Satellite signal with telecom commands. 
● Channel 2: Backup signal via terrestrial digital television (TDT). 
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● Channel 3: Backup streaming signal from the web. 

If silence is detected in the main satellite signal, ZaraStudio switches to the TDT signal. If silence 
is also detected there, it then switches to the streaming signal. When the original satellite signal 
is  restored,  ZaraStudio  automatically  switches  back  to  it,  stopping  the  rebroadcast  of  the 
backup channel.

8.2.4. Mixer

You can use any Windows application audio sound card mixer. Type in the location of the mixer 
program file  or  Browse  for  the  location.  When the  mixer  icon  on  the  top  tool  bar  of  the 
ZaraStudio main window is clicked, the mixer application selected will open. 
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8.3. Telecommand

8.3.1. DTMF

ZaraStudio allows you to synchronize your station with another one which uses DTMF tones. If 
you are not associated with any station, disable the detector. On the other hand, if you want to  
use this option, enable the detector and configure it according to your needs. In most stations, 
the disconnection tone is 69. When ZaraStudio detect this tone, it will mute the line-in channel  
and it will do the action selected below: play the list or play the pending events. 

● Pending events: Plays the pending delayed events. When it finishes the playback, it 
plays  the  playlist  until  the  connection.  If  there  are  no  pending  events,  it  will  play  
nothing.

● Play  the  list: Plays  the  playlist  normally  (chaining  the  events  if  needed)  until  the 
connection arrives.

In order to connect you may choose three different options:
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● Tone: Some radios emit a tone to disconnect and another one to connect. If this is your 
case, check this option and specify the corresponding tone (it usually is 90).

● After X seconds: There are radios that choose to set the disconnection time to a fixed 
number of minutes. If this is your case, check this option and specify the duration of 
your disconnections. Once that seconds have passed since the disconnection tone was 
received, ZaraStudio will stop the playback and it will open the line-in channel.

● Don't connect or connect manually: In this case, ZaraStudio goes on playing the list 
and the events and it doesn't connect to the line-in. Also, it can be used to make manual  
connections. Suppose you want to launch a sequence with commercials and reconnect 
when it finishes. You could achieve that by adding a connection to satellite command at 
the end of the sequence.

If  your  network  disconnections  have  different  lengths,  you  can  use  the  command satellite 
countdown. When this command is executed a count down is started, whose length is set by  
the user. While this stopwatch is running, ZaraStudio goes on playing the playlist or the events 
normally. When this counter reaches zero, it stops the playback and it connects back to the 
satellite. Then, we will show you an example of how to use this command.

Suppose you a have a three minutes long disconnection in which you have to play three twenty-
second ads. As the commercials don't cover the whole local window, we will let ZaraStudio fill it 
with music from the main playlist.

In  order to solve the disconnection,  we are going to create a  sequence with a  countdown 
command and four ads. To insert the command, go to Playlist > Add satellite countdown.... 
We will enter three minutes in the dialog that will appear (00:03:00). Now, let's insert four ads  
after the command. Then, we will get a list as the following one:

Now, save the list as a sequence and schedule it as a delayed event some minutes before the 
estimated disconnection time. When ZaraStudio receives the disconnection tones, it will play 
the sequence we have just created. In first place, the countdown will start and, while it reaches 
zero, the ads will be played. When the sequence is finished, it will go to the main playlist and 
will  play its contents until  the three minutes are reached. In that moment, it will  reconnect  
automatically.

ZaraStudio also considers the possibility of making local programs, in which you want to ignore 
the tones sent by the mother station. When that situation happens, you can insert commands 
in the list or in the events to enable/disable the DTMF tone detector.
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8.3.2. Parallel port

It is possible to control ZaraStudio with external devices, like a mixer or a satellite decoder, by 
using the PC's parallel port. These devices produce pulses or contacts that fire a specific action 
when are detected in the computer, like connecting to another station.

Starting from Windows Vista, for this feature to work correctly, you have to run ZaraStudio as 
an operating system administrator at least once, as it is needed to install a driver to access to 
the parallel port.

Currently, this features works on both 32 and 64-bit systems. It works with built-in parallel ports 
and with PCI or PCIe cards. However, it is not compatible with USB converters. This is not a 
limitation of ZaraStudio but rather of this type of converter, which is designed exclusively for  
use with old printers.

To enable this function, you must activate the option Allow control through the parallel port. 
Once this  is  done,  select  the port  you wish to use to control  ZaraStudio and configure its  
address. To find this information, go to the Windows Device Manager. Then, right-click on the 
parallel port device, which should appear under the Ports section, and select Properties:
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This will open a dialog box. Navigate to the Resources tab and check the address listed first in 
the I/O Range row:

In the example image, the address would be CC00. For ZaraStudio to interpret it correctly, you 
must also add the prefix "0x" (with the number zero as the first character), so in this case, it  
would be 0xCC00.

Now,  you  have  to  configure  the  actions  you  want  to  execute  when  a  pulse  or  contact  is 
detected in the parallel port pins. This is the pin distribution in the connector:
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We are going to use only pins 2 to 9 and pins 10, 11, 12, 13 and 15. The former are output pins,  
that is, the computer writes on them, while the latter are input pins, that is, the computer reads  
them.

Each pin has two different signal states: high (5 volts) or low (0 volts). A voltage change from low 
to high is called a rising edge, while the contrary case is called a falling edge. ZaraStudio can 
detect both cases and it carries out the action specified by the user in each case. Besides, there 
are always 5 volts in pins 2 to 9 (this is only true while ZaraStudio is running) and in pin 25 we 
always have ground (0 volts).

Now, let's see how to make the physical connection. Suppose we want to connect a decoder 
that makes a contact when there must be local  programming and the contrary in national 
programming. This is a possible way to make such a connection:

Let's see how the circuit behaves on each case:

● Local programming: the switch at the left is closed, so pin 10 is connected to ground (0 
volts). The pin will be in low level.

● National programming: the switch will be open and pin 10 will be connected to pin 2, 
which has 5 volts, through a resistor, so pin 10 will be in high level.

So, when switching from national programming to local one, a falling edge will be made (in this 
case we would select the Disconnection action in the options dialog), while, on other hand, a 
rising edge will be made (in this case we will select the Connection option).

Feel free to contact us if you have any questions about how to connect a specific device.
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8.3.3. Serial Port

ZaraStudio allows telecommand reception from a satellite receiver through the computer serial 
port, without needing a physical relay box device.

This system works through 8 virtual relays, whose state is received from the mother station by 
means of the serial port. In order to use this feature, you have to check the Allow to control 
the program through the serial port option. Then you must set the port you want to use to 
establish the communication:

● Port: Indicates the serial port number to use. This field allows writing, in case you 
need to type a special port number.

● Baudrate: Speed at which communication will be established. This speed should 
be  the  same  as  the  one  set  in  the  mother  station  to  send  the  information. 
Otherwise, reception errors might happen.

Once you have set the connection parameters, you have to select the relays you want to use. 
ZaraStudio will  ignore orders coming from non-selected relays. This lets the mother station 
send disconnection commands on a selective way to a station or group of stations without the  
rest noticing.
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Finally, you have to choose the actions that will be carried out every time a relay is closed or 
opened. There are several options:

● None. The application will carry out no action.

● Connection to channel 1-10. Reconnects to the network through the line-in input 
of the sound card corresponding to the selected channel (or streaming signal if 
configured as such), stopping the playback of local audio.

● Disconnection + List. Interrupts the audio coming from the satellite and starts 
the main playlist audio playback.

● Disconnection + Events. Interrupts the audio coming from the satellite and starts 
pending telecommand events playback.

● Playlist. Starts playing the main playlist.

● Events. Plays pending telecommand type events. If there are no pending events, it  
does not interrupt the sound from the satellite and ignores the disconnection.

● Stop. Stops playback.
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8.4. General

8.4.1. Database

This window allows you to set the Firebird database connection parameters. 

It also enables you to configure the connection to the notifications server. The notifications 
server makes it  possible to keep the database information synchronized in all  the network 
terminals running ZaraStudio. When a user makes a change in an audio in a terminal,  this 
terminal sends a message to the notifications server, which, in turn, distributes this message to 
all the other terminals and the information is automatically updated.

The standard settings are usually valid for most installations.
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8.4.2. Log

It allows you to configure log files. ZaraStudio stores the time at which each is audio is played in 
these files, warning also of possible errors. Prelistens are not logged (unless an error happens),  
in contrast to the jingle palette audios. By default, both the primary and secondary instances 
write messages to the log file. If you don't want secondary instances to log, then check the  
option Log only when using the first instance.

Log files are text files, but with the log extension. They can be opened with any text editor, such 
as Notepad. It is generated one log file per day, for them to be easy to handle. If you want to 
find a concrete event, you can browse these files through a tool called Auditor, reachable from 
the Tools menu.
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8.4.3. Explorer

It allows you to configure several parameters related to the audio explorer:

● File  importer.  Indicates  how files  are  processed when they are  imported to  the 
database.

 Title extraction.  ZaraStudio uses the file names to fill out the Artist and Title 
fields, as long as they are named with the “Artist – Title” convention. If it is not the 
case, you can also take that information from the files ID3 tags.

 Detect marks. When this option is checked, ZaraStudio scans the files to find out 
their optimum mix marks, taking into account the audio levels set above. It works 
in the same way as the ZaraOverlap tool. If this option is not checked, ZaraStudio 
will take the marks from the file name, as long as they have been set manually 
with the ~ symbol.

● Extensions.  Indicates  what  kind  of  files  will  be  displayed in  the  hard  disk  audio 
sources.
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8.4.4. Random tracks

This page of the options dialog allows to customize the way in which songs are picked when 
using random tracks from folders (Playlist > Add random track...)  and from the database 
(Playlist > Add database random track...):

● Random tracks from folders

 Do not repeat songs until  the whole folder has been played.  ZaraStudio will 
choose a file from the folder randomly, but it won't repeat any one until all files it 
contains have been played. It does not guarantee a file is not played twice in a row, 
though it is quiet difficult for that to happen in folders with lots of files.

 Separate songs of the same artist. When enabling this option, it won't repeat any 
artist until  the random track has been played as many times as specified in the 
numeric field which is just under the option. For this system to work properly, it is 
necessary  to  have  the  files  named  with  the  format  'Artist  –  Title'  (without  the 
quotes).  For  example,  a  file  correctly  named  would  be  Alicia Keys – No 
one.mp3.

 Ensure minimum separation until repetition. When activating this option, it is 
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guaranteed that a song won't be repeated, at least, until the random track has been 
played as many times as specified in the field just under the check box.

● Database random tracks

 Random level. Indicates the randomness percentage of the music selection. It can 
vary  between  0%,  providing  a  fixed  music  sequence  without  any  kind  of 
randomness in which the song with longer rest time is always chosen, and 100%, 
providing a totally random music sequence in which all the songs are candidate to 
play, as long as they meet the separation requirements. For example, with a 20% 
random level, the selection would be done over the 20% of the songs with longer 
rest time.

 Separate songs of the same artist. When this option is checked, ZaraStudio will 
not  repeat  an  artist  until  the  specified  amount  of  time  has  elapsed  (up  to  a 
maximum of 1440 minutes). Note that, in this case, the separation is indicated in 
minutes rather than songs.

 Ensure minimum separation until  repetition. When this  option is  checked,  a 
song will not be repeated until the specified amount of time has elapsed. 

Keep in mind that the more restrictive the selection is, the longer it will take it to do it and the  
chances of repetition increase, since in case of some criterion can't  be met,  a track will  be 
repeated randomly.

Besides, we recommend to use database random tracks for music programmings, as they have 
the following advantages:

● The songs are chosen faster.

● The system remembers the date and time when every song was last played, while 
plain folder random tracks only remember the last played songs.

● You can use the random level  feature,  which is  more flexible and generates less 
conflicts than forcing the playback of all the folder songs before repetition.

● You can use network folders.
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8.4.5. Tags

By default, in the playlist are the names of the files. Nevertheless, for MP3 files, it is possible to 
show ID3 tags. In order to show them, simply check Enable tags. Type the desired info macros 
(listed below the box) into the Format box. The tag info represented by the macros will appear 
in the playlist in the order listed in the Format box. 
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8.4.6. Talk over

Here you can set the level to reduce the currently playing track to when Talk over is activated. 
Also, time to reduce the level can be set here. These parameters are set for both voice tracking 
and the talk over button, located on the bottom button bar.
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8.4.7. Weather

It allows you to configure the data for temperature, humidity, wind speed and direction, and 
sky conditions. ZaraStudio can import this data from any application via a text file or retrieve it  
automatically from the OpenWeather website. To do so, you must choose the corresponding 
option from the Data Source dropdown menu.

If you choose to collect data from a text file, you must configure the folder where the file is  
located through the File Path field. The file format should be as follows:

[weather]
temperature=<temperature>
degreeType=<C (for Celsius) or F (for Fahrenheit)>
humidity=<humidity>

For example:

[weather]
temperature=17
degreeType=C
humidity=32
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If you choose the OpenWeather option, you must select the  City for which the data will be 
downloaded. ZaraStudio is pre-configured with an access key for OpenWeather, limited to a 
maximum number of requests per minute, which is shared with other ZaraStudio users. If the 
maximum number of requests is exceeded, the weather data download will fail. To avoid this 
issue, it is recommended that you register on OpenWeather and obtain your own private key to 
download  the  weather  data.  You  can  do  this  by  visiting  the  website 
https://openweathermap.org/api. Then, subscribe to the Current Weather Data option.

Once this is done, you can specify your key in the OpenWeather API Key field.

Finally, you can configure the units in which the temperature will be displayed, with options for  
Celsius and Fahrenheit.

A potential issue that might arise is losing the internet connection at night, which could result in 
broadcasting incorrect weather data. To address this, you can set ZaraStudio to not broadcast 
the temperature and humidity announcements if the application collecting the data has not 
updated  the  file  for  a  certain  period  of  time.  To  do  this,  check  the  box  Disable 
announcements... and specify the maximum validity period for the weather information.
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8.4.8. Folders

This windows lets you set the folders that will be used by several modules of the application:

● User settings folder.  There are certain preferences in ZaraStudio, such as the 
layout of the players or the font size, that are independent for each user. Through 
this option, you can specify the folder where the application’s user profiles will be 
stored. If you have a network installation with multiple terminals, we recommend 
that this path points to a shared folder on the local network and is the same on all  
PCs. This way, when users access ZaraStudio, they will  retain their preferences 
across all terminals.

● Schedules folder. Indicates the folder in which commercial schedules generated 
with the Schedule editor are stored. Similar to the previous option, if you have a 
network installation and all the stations share the same schedule, you may want 
this path to point to a shared folder on the local network.

● Events file folder. Indicates the folder where the events file (events.ini) will be 
stored. Events are now stored in a file rather than the registry.

All  these paths may point to network shared folders.  This is  useful  when you have several  
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ZaraStudio terminals in a local network and you want to share the settings among them.

8.4.9. RDS

ZaraStudio generates two text files, CurrentSong.txt and NextSong.txt, containing the title of 
the currently playing audio and the following one. These files can be used, for example, to 
display its information in the RDS radiotext or on the website of the station. This window allows 
you to configure various aspects of these files:

● Output folder. Indicates the folder in which these files will be generated.

● Static text. The text contained in this field will be displayed when an audio file whose 
title should be hidden is being played.

● Audio types to include. Indicates the database audio types whose titles should be 
displayed in the files. The static text will be displayed with unchecked audio file types.

Please, take into account that ZaraStudio only generates the text files needed to feed the RDS 
encoder, but it does not send this information to the physical device. It does not generate the 
RDS signal either.
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8.4.10. General

In this screen, you can configure various general options for ZaraStudio. It is also possible to 
make adjustments to the audio system in case you experience playback issues:

● Audio System: Allows you to choose between WASAPI (the system used in Windows 
since Windows 7) or DirectSound (the system used in Windows XP).

● Device Buffer:  Allows you to configure the size of the internal buffer for the audio 
engine. A larger buffer size results in more delay in playback, but a lower chance of 
micro-cutouts. This option may need to be enabled when working with audio over the 
network using the Dante protocol.

Other ZaraStudio options:

● Language.  Language  of  the  user  interface.  This  option  only  takes  effect  when 
ZaraStudio is started.

● Enable  Autostart.  Causes  ZaraStudio  to  automatically  play  the  playlist  when  the 
program is opened.
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● Launch  program  at  system  startup. Runs  ZaraStudio  after  system  startup 
automatically.

● Open the last list at startup. If checked, Windows remembers the playlist that was 
active when ZaraStudio was closed and reloads that list when ZaraStudio is reopened.

● Shutdown confirmation. When leaving the program, it asks the user if he really wants 
to quit the program.

● Play tracks by double-clicking on them. By default, when double-clicking an item in 
the playlist, the green marker moves to that item, indicating it is next up. By activating 
this  option,  the  track  plays  immediately  when  double-clicked,  not  waiting  for  the 
currently playing track to end.

9. Hot keys (former audio palette)
ZaraStudio has  a  hot  keys  system that  allows you to  trigger  audio  using buttons with  the 

mouse. To do this,  click the   button in the top button bar and choose the Hot keys 
option. When you do this, a new window will open, similar to a player:

This window has 20 buttons, to which you can assign different audio files that you want to  
trigger. It also has 10 different pages of buttons, which can be selected through the dropdown 
at the top, so the total number of available audios is 200. You can assign a name to each page 

for easier identification by pressing the  button.
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To assign an audio file to a button in the palette, simply drag a file from Windows Explorer or  
ZaraStudio and drop it onto the desired button.

Besides, the buttons have a context menu, which can be accessed by right-clicking on them. 
That menu has the following options:

● Clean button. Resets the button, removing the audio file and leaving it empty.

● Cue. Prelistens the audio assigned to the button.

● Normal. Activates the normal play mode.

● Loop. The audio will continue to repeat until audio button is pressed again.

● Sweeper. Before playing the jingle,  it  decreases  the volume of  the main playlist, 
restoring it when the jingle has finished.

To change the page,  use the drop-down selector  at  the right  of  the palette.  You can also  

rename a page by clicking on the button , located at the left of the page drop-down.

10. Time and weather announcements
ZaraStudio  can  announce  the  time,  temperature  and  humidity  automatically  using  pre-
recorded audio clips. These announcements are inserted into the playlist (Playlist > Add time 
announcement) or event lists as commands. For this to work, the audio clips must be located 
in  the  folders  Time,  Temperature  and  Humidity  created  when  ZaraStudio  was  installed 
(normally in c:\Program Files\ZaraSoft\ZaraStudio)

10.1. Time Folder
This folder contains audio clips of the spoken hours and minutes. There are three types of files: 

● HRSXX.mp3,  where  XX is  the  corresponding  hour  (from 00 to  23).  These files  must 
contain audio clips that say something similar to "It's XX". Example: the HRS02.mp3 file 
could say "Time now, 2". This will be followed by the minute file.

● MINXX.mp3, where  XX is the corresponding minutes (from 00 to 59). These files must 
contain audio clips that say only the number of the minute. Example: the MIN53.mp3 
file would say "53". When preceded by the hour clip you have “Time now, 2:53”.

● HRSXX_O.mp3 (the last character is the letter O, not a zero). This file must contain an 
audio clip  that  says something like "It's  XX o'clock".  Example:  the  HRS14_O.mp3 file 
would say "It's 1400 hours" for 24 hour format or "It's 2 PM o'clock" for 12 hour format.
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10.2. Temperature Folder
This folder contains audio clips of the spoken temperature. There are two types of files: 

● TMPXXX.mp3, where  XXX is the corresponding degrees (000 to 100, for example). You 
only need to have audio clips for the anticipated range of temperatures. Depending on 
whether you use Celsius or Fahrenheit the range of numbers will vary. For example, the 
TMP020.mp3 file could say "We have a temperature of twenty degrees". 

● TMPNXXX.mp3,  where  XXX is  the corresponding degrees below zero (000 to 010, for 
example).  The  TMPN002.mp3 file could say "We have a temperature of two degrees 
below zero". 

10.3. Humidity Folder
This folder contains audio clips of the spoken humidity: 

● HUMXXX.mp3, where XXX is the corresponding humidity (000 to 100). For example, the 
HUM035.mp3 file could say "We have a humidity of 35%". 

11. Voice tracking
ZaraStudio can play sound files, as well as time, temperature and humidity announcements 
over other sound files. This is known as voice tracking. 

ZaraStudio has two types of voice tracking:

● Voice tracks linked with specific audios. Voice tracks are played every time its 
associated audio is played. It does not matter what list is opened.

● Voice tracks linked with playlist audios. In this case, voice tracks are linked with 
a specific playlist item. This way, the same audio can have different voice tracks in 
different playlists.

If an audio has both types of voice tracks, the second type will be used.

11.1. Voice tracks linked with specific audios

In order to use this feature, you have to press   and select Voice track editor... After 
doing that, the following dialog will appear:
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This dialog displays all the voice tracks. The first column shows the name of file on which the 
voice track will be played. The second column displays the voice tracks, and in the last one, the  
instant  in  which  the  voice  track  will  be  played.  This  way,  you  can  link  music  files  with 
presentations.

Every time the audios in the first column are played (in a playlist, in an event,...), the voice track  
in the second column will do too. If a file has more than one associated voice tracks, i.e., if it  
appears several times in the first column, one of them will be chosen randomly.

 Besides, there are the following buttons:

● Add...: It allows to add a new voice track to the list. When pressing this button, a new 
dialog will open, in which you will be able to set the data corresponding to the columns  
described above.

● Modify...: It  allows to modify the selected voice track.  This button opens the dialog 
described in the Add button.

● Delete all: Removes all the voice tracks from the list.

● Delete: Removes the selected voice tracks.

● Open...: It allows to import a previously saved voice track list.

● Save...: It allows to export the current voice track list to a file.
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11.1.1. Add dialog

This dialog lets you link an announce with a song. In order to do that, you have to follow these 
steps:

1. Select the song over which you want to place an announce or voice track. You can 

do this by clicking the button , in case the song is located in a hard disk folder, 

or , in case it is stored in the database, and choosing the desired file.

2. Set the instant at which the voice track will be played. There are three options:

a) Play during intro time. If an intro time has been associated with the song, 
the voice track will be played during that period, so that the announce ends 
two seconds before the singer starts singing.

b) Play just before overlap time. The announce will be played just before the 
song ends.

c) Play after X seconds. It allows you to set the exact second at which the voice 
track will be played.
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3. Choose the announce or voice track. You can do that at the bottom of the window. 
It may be a fixed file, a random track, a database file, a database random track, or 
a time, temperature or humidity announcement.

11.2. Voice tracks linked with playlist items
In order to link a voice track with a playlist item, just select the file on the playlist and press the 
right mouse button. A pop-up menu will display:

Then, click on  Set voice track....  After that, a dialog like the one described in the previous 
section will open. Enter the voice track details and press OK.

If you later want to remove the voice track associated with a playlist item, just open the pop-up  
menu and click on Remove voice track.

This not only may be used with specific audio files, but also with random tracks.

11.2.1. Enabling and disabling

Voice tracking can be enabled or disabled globally in the whole application through the  
button on the top button bar. When this button is pressed, voice tracking is enabled.

Furthermore, you can automate this task by scheduling commands or by inserting them into 
the playlist.

Finally, to easily identify what playlist items have an associated voice track, ZaraStudio will show 
their description in blue color.

12. Templates
Templates allow you to define random music programmings. This way, you can set the music 
styles you want to play, how often jingles are going to be played,...

A template is made up by a sequence of random tracks and/or specific audios in a certain 
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order.  When  a  template  is  loaded,  ZaraStudio  adds  audios  to  the  playlist  automatically, 
following the template pattern. If it finds a random track, it adds a random audio from the 
specified folder; if  it  finds a specific audio, it  will  be added directly.  As the player plays the  
inserted audios, the application adds more at the end, generating an infinite playlist.

12.1. Template creation
The process of creating a template is similar to creating a conventional list, so this task can be 
done in any player. The following image shows an example of a template consisting of random 
tracks, though it is also possible to insert specific audios or even voice tracks.

Once it is created, you only have to save it. The saving process is the same as for a conventional 
list, except you have to choose the TPL file type in the save dialog, as shown in the following  
image:

12.2. Template loading
You can load a template in a player in one of three ways:

● Manually. In this case, you have to select Open template... in the  menu of 
the player.

● Through  an  event. Templates  can  be  loaded  automatically  using  an  event 
associated to a TPL file.

● Through a playlist. Inserting a TPL file in a playlist, will make the template load 
when the player reaches that item.

Once  a  template  is  loaded  in  a  player,  ZaraStudio  will  add  audio  files  to  it  automatically, 
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following the pattern specified by the template.

In the following image you can see how a player looks like after loading the template created in  
the previous section:

13. Auditor

In order to open the log browser, execute the button   and select  Auditor. After doing 
that, the following dialog will open:

With the auditor tool, you will be able to know at what times a file has been played, in a given 
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range  of  dates.  Besides,  you  will  be  able  to  export  your  search  in  TXT  format,  to  give 
transmission reports to your customers. You have to specify the name of the file you want to 
look up in the File field. It is not necessary to write the full path of the file. For example, if you 
want  to  look  up  a  file  named   c:\ZaraStudio\spots\spotZaraStudio.mp3,  typing 
spotZara would be enough.

Furthermore, you can filter your search by event type or player:

● File: It allows to look for the specified file, within the log files.

● Errors: It allows to look for all the errors such as broken files, missing files, and so on.

● Warnings: Limits the search to warnings, such as event deletion because maximum 
wait has been reached, song repetition in random tracks,...

● Start up: Looks for the times at which ZaraStudio has been executed.

● Shutdown: Looks for the times when ZaraStudio has been closed. 

● All: It displays the full content of the log files, in the given range of dates.

Besides, you can limit the search to a specific player. Some events, like startups or shutdowns,  
are not linked with any player, so they will always appear, regardless of the chosen player.

After choosing what you want to find, you must choose the range of dates in which the search  
will be done. Then, you can start the search by pressing the Search button. Once the search 
has finished, the results will be displayed in the list.

Then, you can save the list in a file by pressing  Export....  Besides, you can export it in CSV 
format. It is a text file, compatible with most calc sheets programs, like Excel or OpenOffice 
Calc.

14. The auxiliary players
ZaraStudio has four auxiliary players with almost the same features as the main playlist. In  
order to open this players, you have several options:

● Press the button  and select the options Aux 1..4.

● Press Ctrl+1,..., Ctrl+4. 

After doing one of the steps described, the auxiliary players will appear anchored at the right 
side of the ZaraStudio window. These players looks like this:
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Its  use is  similar  to  the one of  the main playlist  (see playlist  and main window).  The only  
noticeable difference is that events are not chained between the auxiliary player items. So, 
when letting ZaraStudio playing an automatic  programming,  we must use the main player, 
while the auxiliary players are indicated for manual use.

15. Users and permissions

15.1. User management
ZaraStudio has a user management module, what not only allows to limit access to certain 
application modules, but also to provide an independent window configuration to each user.

In order to access to this module, you have to execute Tools > User management. After doing 
this, the following dialog opens:
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By default, the application has two predefined users that cannot be removed, to prevent the 
program from running out users:

● Default. This is the default user used by the application when it is opened. It is a  
user with very limited permissions, so it does not have a password.

● Admin.  This  user  has  administrator  permissions,  i.e.,  it  can  access  to  all  the 
application modules.  It  is  not an independent user,  but it  provides this access 
condition to the current user. The default password is “admin”, but you can modify 
it at any time.

This dialog also has the following buttons:

● New: Opens a window that lets you create a new user and assign permissions.

You have to fill out the following fields:

90



User manual ZaraStudio

 User. It is the name used to log-in in the application.

 Password. Password used by the user to log-in in the application. You have to 
type it twice, to avoid spelling mistakes.

 Current user as administrator. When this box is checked, a special user is 
created.  This  user  gives  full  permissions  to  the  currently  logged  user, 
regardless of its access condition. This is useful, for example, to modify the 
window configuration users that do not have this permission.

In  addition,  the  Permissions tab  allows  to  assign  to  the  user  the  desired 
privileges:

 Open lists. Allows the user to open an existing playlist.

 Save list. Allows the user to save changes made to the opened playlists.

 Modify list. Allows to change opened playlists (pasting audio files, dragging 
files from other windows, moving audio files,...).

 Change mode. Gives access to the playlist mode dropdown. This also allows 
the user to enable or disable the events in that player.

 Schedule events. Lets the user access to the event scheduler.

 Delete pending events. Gives the possibility to remove the pending events.

 Reload events. Reloads all the events of the day, discarding all the manual 
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changes made on the schedule.

 Manage disk audio sources. Allows the user to create, modify and remove 
disk audio sources.

 Manage  database  audio  sources. Allows  the  user  to  create,  modify  and 
remove database audio sources.

 Create  folders. Allows  the  user  to  create  new folders  on  database  audio 
sources.

 Modify folders. Allows the user to modify existing folders on database audio 
sources.

 Delete folders. Allows the user to remove existing folders on database audio 
sources.

 Create audios. Allows the user to import new audios to a database audio 
source.

 Modify audios. Allows the user to modify the properties of an existing audio.

 Delete audios. Allows the user to delete audios from the database.

 Auditor. Gives access to auditor tool.

 Voice track editor. Allows to access to the voice track editor.

 Options. Gives access to the options dialog.

 Manage users. Gives access to the user management window.

 Minimize ZaraStudio. Lets the user minimize ZaraStudio's main window.

 Close ZaraStudio. Offers the user the ability to close the application.

 Modify  window  configuration. Allows  the  user  to  customize  the  window 
layout. If this permission is not set, the windows will be blocked and the user 
will not be able to move or close them. New windows will not open either. To 
modify the window configuration, an administrator account will be needed.

● Edit: Allows to modify the password and permissions of the selected user.

● Remove: Removes the selected user.
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15.2. User change
To log in as another user, select Tools > Change user. After that, the following authentication 
dialog will open:

You will  have to enter your user name and password in this  window. If  the information is 
correct, the window configuration of the user will be loaded and the application modules to 
which it  has access will  be enabled. When the program closes or another user logs in,  the 
window layout will be saved.

By  default,  two  users  are  included:  default  (without  password)  and  admin  (with  password 
“admin”).

Every time, the application top bar will display the currently logged user name:

16. Music programmings
Now let’s look at an example of how to use ZaraStudio to automate a real situation for a music  
station.

First,  it’s  important  to plan a folder  structure on your computer for  all  the station's  audio  
content. You should also decide whether to use the database, disk files, or a mixed alternative.

For this example, let’s create the folder structure on the computer:

We wish to broadcast the following schedule:

● From 8 AM to 10 AM, nostalgic music, alternating two Spanish artists with one foreign 
artist. 

● From 10 AM onwards, current music, alternating one Spanish artist with another foreign 
artist. 

93



User manual ZaraStudio

● Between songs, a station ID will be broadcast. 
● At half past the hour, a commercial break will be broadcast without interrupting the 

song that’s playing. 

16.1. Creating the music playlists
Let’s start with the 8 AM playlist.  To create the music schedule, we will  use random tracks. 
These are elements that are inserted into playlists by referencing a folder on the computer, and 
when played, they select and play a random audio file from the referenced folder. Additionally,  
through Options > General > Random Tracks, you can adjust the separation between repeating 
artists and the same song.

First, we create an empty playlist by pressing the button on any player and selecting New from 
the dropdown menu. Then, we insert three random tracks by accessing the Insert Random 
Track command in the dropdown menu next to the button.

For the 8 AM playlist, we want to alternate two nostalgic Spanish artists with one foreign artist.  
Therefore, the three random tracks we insert will reference the folders where we store those 
music styles:

● C:\Radio\Music\Spanish Nostalgia 
● C:\Radio\Music\Spanish Nostalgia 
● C:\Radio\Music\Foreign Nostalgia 

We will also insert a random track from the "Station IDs" folder to play a station ID between 
songs.

After inserting the random tracks, the player will look like this:

This way, if we select the Repeat mode on the player, we will achieve the desired alternation.  
We save the playlist in TPL format with a descriptive name like 8h.tpl. To do this, press the 
player button, select Save, and assign the name 8h.tpl.  The TPL format is ideal for random 
music  scheduling through folders,  as  it  automatically  creates  an infinite  playlist  of  random 
music following the folder pattern when generating the playlist.

To create the 10 AM playlist, we will follow the same process, except we will insert the following 
random tracks:

● C:\Music\Current Spanish 
● C:\Music\Current Foreign 

We will save the playlist with the name 10h.lst.

94



User manual ZaraStudio

16.2. Creating the commercial break
For the commercial break, we have two options: using the event scheduler or the schedule 
editor.

16.2.1. Option 1: Event Scheduler

This is the classic method for generating content that needs to be played at a specific time 
(and/or date).

To access the event scheduler, we press the  button on the event player. When doing so, the 
event editor window will open:

Then, press the Add Event button. A new window will open to define the new event, which we 
should configure as follows:
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● Description: a name to identify the event. 
● Duration: the estimated duration of the commercial block (for informational purposes). 
● First execution: set any time to half past the hour. The exact time doesn't matter, as 

we will configure the event to play every hour. 
● Periodicity: select Every hour to make the event play at half past every hour. 
● Start type: select Delayed so it waits for the current song to finish before starting. 
● Event type: select Block, which allows us to play several files with a single event. When 

selecting this, a playlist will appear where we must fill it with the commercial breaks. 

After doing this, the new event will appear in the event editor window:

96



User manual ZaraStudio

16.2.2. Option 2: Schedule Editor

Since  version  3,  ZaraStudio  has  an  independent  schedule  editor,  which  allows  for  better 
organization of the entire schedule for the day compared to the event scheduler, which can get 
complicated when managing a large number of events.

To access the schedule editor, press the  button in the top bar and choose the Schedule 
Editor option. This will open the schedule editor, which is similar to the playlists in the players:
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Then, click the   button to create a new block. A new window will open, which should be 
configured as follows:

● Time: set any time to half past the hour. 
● Description: a name for the block. 
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● Duration: the estimated duration of the block (informational purposes). This option is 
especially useful for stations associated with networks that need to match the exact  
duration of disconnections. 

● Block type: select Delayed so the event doesn't interrupt the song that's playing and 
waits for it to finish. 

● Repetition: select Every hour so the event repeats every hour. 

After doing this, you will see a block for every hour in the schedule:

Next, fill the first block with the desired commercial content by dragging from the Explorer or 

by pressing the  button:
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Now, repeat this content (or vary it if desired) in each block. To do this, right-click on the audio  
you wish to schedule and select Schedule...:
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A new window will open to choose which blocks you want to schedule this audio. In it, select all  
except the first one, as the audio is already scheduled in it:
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Repeat this process for each audio until the schedule is complete:
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Next, save the schedule by pressing the  button. By default, it will save for the day shown in 
the window title, which in this case is Monday. If you want to use the same schedule for the rest 

of the week, press the  button and choose Save Copy. A new window will open where you 
should select all days of the week:

This will save the schedule for all days of the week. If you only want it for a specific range of 
dates, you will need to check the Date Range box and select the desired range. In this case, you 
would also need to select the desired days of the week, as the schedule would only be saved on 
those days for the selected date range.

Once this is done, the commercial schedule is ready. As you can see, this process is more labor-
intensive with the schedule editor, but it provides a clearer view of the scheduled content.

After completing these steps, you will  see that the event player now shows the commercial  
blocks created:
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16.3. Creating the music events
To ensure the station broadcasts the musical styles at the desired times, we will need to create 
two more events that load the playlists created earlier. Again, we have two options: using the 
event  editor  or  the  schedule  editor.  These  two  options  are  compatible,  meaning  we  can 
schedule the commercials with the schedule editor and the music events with the event editor.

In this case, for our example, let’s assume we want to use the event editor. We access it and 
create an event as follows:
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● First execution: choose 8 AM, the time we want the music clock to load. 
● Periodicity: this time, it will be Once a day. 
● Start type: it will be immediate, as we want the music clock to start at the top of the 

hour, interrupting whatever is playing. 
● Event type: since we only want to load a single file, choose File and load the playlist 

created earlier (8.tpl) using the lower selector. 

We will repeat this operation with the 10h.tpl playlist but load it at 10:00 AM. After doing this,  
the event editor will look like this:
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Press OK and observe that the event player has loaded the events corresponding to the music 
playlists:

Now, simply select  the automatic  mode and press  Play on the main player.  For automatic 
mode, select Auto+List, so after each event, ZaraStudio will switch to playing the content from 
the main player.
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That’s it; our schedule is ready!
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